Converting an S96 File into an IGES file for Cam Grinding

Converting an S96 file into an IGES
file can be either for a cam profile that
was measured by a method different
than using the Cam Analyzer, or from
a cam profile designed for a particular
follower type.

You will need the Cam Grinder version
of Cam Analyzer to do this.

First, open the file. You will see Cam
Analyzer say it is an S96 file.

The Cam Analyzer will present a screen where you

can enter some details about this lobe.

these do not matter if you are going to make
an .igs file. That is because most of these items
have to do with valve (not lobe) lift and what you

want to name this lobe.

Then click on the Make File button.

Lobe on Main Screen after it is imported.

Click on Test/Cam Setup to proceed to next page.
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w| Open Test File

¥ Tests in Library

CF23EF imported

CF23EF imported converted
cf236L imported converted 2
cf236f imported corverted B0
CFZ3BF P

| CF236F P 001
(CF,

Open | Filter [find] | Advanced [browse] |

S-96 File
(® List Al Files by File M ame Folders
() List by File Marme [include Cam #) cad3 eror ~
) List by Cam # [include File Name) CaLc
) List by Date File was Last Saved Eﬁ;lll-fsthecker
Filez Mat Filkered [all files listed]
Centerz - news CTS design b

Chosen File: CF236F.536

Presview:
Cam File Type: 5-96

Delete | Tip: Click on a different Folder name o display all

Cancel | Help | Delete |

| Cam File Options
DOptions for Aeading S-96 File

the tests zaved under that Folder Mame

Add

Right click in list abowve for maore Folder Options

Cam File Name & Folder

|[CF23eF 5097 |

Lifter Type Mild Solid Flat - File Mame
Most of . e —
For Which Type Lobe |Intake j [Falder

Azzign to This Cyl #
Int Rocker & R atio
Int W alve Lazh

Int Centerline

1 hd

[ ]
[ ]
[ 1]

|Ean0ll Ford ﬂ

[ ]

*" Create new file from this file
" Add this lobe to the exizting file

Notes:

Select or enter the specs you want to uze for this
can file. &l specs must be entered before pou
can click on the 'Make File' button. [For Cam Pro
Plus, specs may be filled in bazed on settings in
file, but theze can be changed here.] Select
‘&dd Mew' from Folder lizt to add a new folder.

Make File ‘ Help ‘ Cancel ‘ Print |

E Cam Analyzer v4.3 ‘Cam Grinder® Performance Trends [ CF236F.S097 ]
File Edit Graphs Reports Test/CamSetup Find TDC Settings Help

Intake #1 )

Test & Valve Train Conditions
Test Comment:

Reg To; Hamms Machine

Exhaust 1 1

Test Piece Picture

Test Time/Date 10:53 am 12/06/2010

Cam Number T
Grind Number e =]
Rcki Ratio/Lash  Test Operatar

B/ 2 Damyl B

i |

Test Data

| Show Degree Wheel

Paint [Degree. |Tappet | ~
el Lift
74 ATDC

76 4TDC 000
78 A4TDC 000
80 ATDC 000
52.ATDC 000
54 4TDC 000
96 ATDC 000
88 ATDC 000
50.BEDC 000
58.BEDC 000
96.BEDC 000
54.BEDC 000
52.BEDC 000
50.BEDC 000

‘m‘m‘ﬂ‘m‘m“‘u‘m‘g

=

b}

b}

=

o

78.BEDC 000
3¢ BenC o

In




Here you want to change the BT #eTq Tz dT o E|

“Type of Cam Data” from Back (ok)  Print  “alve Springs  Help  Refresh
F_rom S96 Fllle "to Mee_lsured Test Setup Lift for Rating Events 050 inch (1.25 mom =]
with Electronics”. This is Type of Cam Data o wheel
eqrese [=1-]
needed so you can do the | Frarm S96 File - Intake =l =
Virtual Follower feature. ype |TDC-90-BDC-90-TDC |

From Comp Cam's File - Exhaus »

Frorm Dt Dioctor File - Intake

From Dir Dioctor File - Exhaust
596 File - Intake

From S39E File - Exhaust

From Andrews File - Intake

From Andrews File - Exhaust

bl eazurad with Electronics

-
Rocker Arm Ratio |1 b6 _|
|
|

For Cyl #

Actual Yalve Lash. in |_I]2
Centerline. deg ATDC |1 10

You will receive several
message screen instructing |
you what is happening in this | on th butor ot hot ,
anm ata Was generated. oo zelec enerate
process. Choose Yes or OK | fram Cam Specs’, you can alzo specify the tappet lift

for these messages. from which duration and opening/closing eventz are
9 llctaliEamisdance | ﬂ measured. American aftermark.et standard is 050",

| | betric and motorcycles use 040 [1 mm]. Seat
timing iz alzo called 'adwertized' duration and iz not a=

| Help: Hotes on Highlighted Item
Click on the down arrowe button to select how the

accurate a method, p 21 IMPORTAMT: Select
'Meazured with Electronics’ if you are uzing the Cam
Test Stand.

Change Type of Cam Data Anyway?

The: program wil now canvert your data to a Format much ke it was Measured with Electronic Sensars (800 crank deqrees, 2 deg increments, etc), This will be a major change to the data, but wil allow you t do addiional types of analysis,
After this change, yau wil NOT be able ko retur to the origingl data,

Tt is recommended vou save this data, and then save again o a New Name before you continue, That way vou CAN go back ko your old data file if need be,

fire yau sure you wank to make this change o the Tvpe of Cam Diaka now?

Convert to ‘Measured by Hand" Now?

To canvert from this daka bype will require 2 steps, Firsk, the data must be converted to 'Measured by Hand', Do you want bo do that now?

Cam Analyzer

The conversion to ‘Measured by Hand' has been completed, Mow vou can select 'Measured with Electronics' to complete the conversion,
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Like the messages say, | Test/Cam Setup

the program will first , :
con\F/)ertgthe S96 file to the Back {ok)  Print  Yalve Springs Help  Refresh

Type “Measured by Test Setup Lift for Hating Events |.|:|5|:| inch [1.25 mmﬂ
Hand”.
Type of Cam Data Deqg Steps Degree Wheel
Meazured by Hand | |2de -
| 4 =l J2des || frype [7oc 90 spC 90-T0C -]
Lifter [profile] Type For Cyl #

| Mild Salid Flat EIRES B

Rocker Arm Ratio 1.6

Actual Yalve Lazh, in |.|]2 | | |
| |

| | | | Help: Motes on Highlighted Item
| | | Click or the down arrow button to select how the

Then it will convert it to “Measured with Electronics”.

Change Type of Cam Data fnyway?

The program will now convert yvour daka ta a farmat much ike it was Measured with Electronic Sensors (300 crank deorees, 2 deqincrements, etc), This wil be & major change to the data, but wil allaw yau to do addiianal types of andsis,
Aifter this change, you wil NOT be able to returm b the ariginal data,

Tt is recommended you save this data, and then save again to a New Name before vou continue, That way vou CAN go back to your old data file if need be,

fire ol stre you wank to make this change bo the Type of Cam Data now?

.................................

Yes ¢ Mo ‘

.................................

Include Base Circle ?

%)

You must enter the base circle for

the cam from which it was Do you want a base cirdle included with this conversion?
measured, OK for the cam which
this profile was designed for. If wou are nok doing a Wirtual Follower simulation (like most users), it is recommended wou click ‘Mo’

Cancel |

What do you want ta uze for Bagze Circle diameter for this 0k
cam, a nurnber from 2 to 10 inches ? -

[f you do not know, enter 1.2 Cancel

In this case, this cam was designed for a .800” base circle.
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Now to do the conversion
for Virtual Follower.

Click on the “See Virtual
Follower Details” button
to bring up the screen
below.

Set the “Follower Type”
for what this cam is
designed for, typically
“Virtual Flat” or “Virtual
Roller”.

The parameters of
“Follower Body

Diameter” and “Standard BB FTLNTE T MG
Back (O + save)

Crown Radius” are not
critical.

The critical setting
for doing this
conversion is
setting the correct

“Probe Radius”.
This will be either to
describe the probe on
the cam lobe when it
was measured, OR the
diameter of the follower
that this lobe was
designed for. In this
case it was designed for
a Flat Tappet so we
chose a very large Probe
Radius of 40”. (The
difference between 40”
Radius and a perfectly
flat follower is negligible.)

When you click Back
(OK + save) at the upper
right the conversion is
made.
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| Test/Cam Setup

%]

Back (ok)  Print  Malve Springs Help  Refresh
Test Setup Lift for Rating Events | (50 inch [1.25 mm ~ |
Type of Cam Data Degree Wheel
Type |TDC-90-BDC-90- TOC -]
Lifter [profile] Type
|5 alid |
Intake  Exhaust
Rocker Arm Ratio 1.6
Actual Yalve Lash, in |_l]2 | | |

Electronic Meazurement Settings

[~

Click here for info on why items are dizabled.

Help: Motes on Highlighted Item
Click an the down arraw button o zelect how the

cam lift data waz generated. |f vou select 'Generate

Lifter Bore Angle Details | Save

| Open

See Virtual Faollower Details | Delete
Adw/Ret

Reralculate Resulks

Edit

Cancel

from which duration and opening./clozing eventz are

| fram Carn Specs’, you can alzo zpecify the tappet lift
| measured. Amencan aftermarket standard 1z 050"

File  Help

Intake

Intake Advanced Specs

Cam Lobe Baze Circle Dia, in

T Exhaust [matches intake]

[® Exhaust Specs Exactly Match Intake Specs

Click here for info on zetting individual baze circles

Follower Type  |\irt,al Flat

Follower Body Diameter, in

Standard Crown Radius, in

JL

842

Probe Radius. in |.-.1|j

Intake Help

=

Pick one of the standard probe radiuses, or enter most
any walue you want. Thiz is the radiuz [not diameter] of
the "probe’ placed on the cam lobe during a
meazurement and iz CRITICAL to enter comectly when
doing any type of a virtual follovwer calculation.

Intake ¥irtual Follower Specs

&

Cam 'Rotation [viewed from front]" is set to Clockwise in ‘Cam Layout Details® screen.

Yiew from Front of Engine

[cd

5|

| Cam Rotation Clackwize A




Back at the = cam Analyzer ¥4.3"Cam Grinder® Performance Trends [ CF236F.S097 ] g@g|

Ma“’] Screen File Edit Graphs Reports TestfCam Setup Find TDC  Settings Help  Record{F5) Reg To: Hamms Maching
the lobe Int #1 | Exh #1 )
does not Test & ¥alve Train Conditions e — Tgsl Piece Picture
|OOk any [[e=Rlineilate Help: Click on one of the M
. Cam Number 1 Tabs here to change to a
different. Grind Humber T = different Cam Lobe.
HOWeVer, Rckr Ratio/Lash  Test Operator
“behind the Dary =l
scenes’ the [Lift: 2681 ][C/L: 109.35 | [Dur: 237.01 |[Open: 7.93 | [Close: 43.08 | [orea: 23.080 | [PkOpen:.280 | [PkNose: - 146 | FkCloss:.229 | [Runout 0002 | [MinDia: 652
Cam Test Data
Anal zer Lift simulated by ¥irtual Flat Show Degree Wheel | watch Cam/Follower |
h y Foint |Degree Tappet |
whesl |Lift P I i
as S L Lift simulated by Virtual Flat
CalCU|at_ed 2 |75.ATDC 00008 0.30
what this 3 |78 ATDC 00008
4 80.ATDC 00003
lobe would 5 |82 ATDC 00003 0.25
look like if a 6 [84.ATDC .00008
“Knife edge’ 7 |96.ATDC 00008
8 88 ATDC 00008 0.z0
3 50. BEDC 00003
fO”ower was 10 (88 BEDC .00002
used to 11 [85.BBOC 00008 kil
12 |84 BBDC .00002
measurethe 13 [82 BBDC 00008 010
cam. This 14 |80.BEDC .0DO0G :
15 |78 BEDC .00008
what the 16_|76.BBDC 00008 0.08
IGS file 17 |74.BB0C 00008
18 |72 BEDC .00008
needs to 19 |70.BEDC .0DO0G 0.00 : ' : ' : ; !
1 20 |68 BEDC .00008 TDC el BDC 270 TDC 450 BDC 630 TDC
descrlbe the 21 |EE.BEDC 00008 = =
phyS|caI 22 |s4.BEDC 00008 Frant Fear
dlmel’]SIOI’]S 23 |62 BEDC .00008
|24 |60.BEDC .00003 Converted from Measured by Hand J1 1 1 J2
of the cam 25 |52 BEDC 00002
26 |56 BEDC 00002
lobe. el e Toncns v

& Graph Options

Graph Specs

To see the difference between Lobes to Graph Mok o
the cam lift profile (what the
follower does) compared to
the actual physical lobe, click
on Graph at the upper left of
the main screen.

‘Pick from List" Data Types

ﬂ Cam Velocity
Cam Acceleration
Cam Jerk
l—_l Yalwe Lift
VYalve Yelocity
I—_l Yalve Acceleration
Yalve Jerk
« ” Raw Cam Data az Measured
Then select the "Type” of =
graph as “Pick from List” to | Cam Radius of Curvature

Type  |Pick from List

open up the choices on the Yalve Lift Frequencies
\ . . « Valve Accel Frequencies
right side. Then pick “Cam

: g Valve Jerk Frequencies
Lift” and “Actual Cam Profile”. Cam Bearing Journals

i C J I d Lob
T | Cam Degrees j Egrtag;‘g];:t an omeE

Then click the Make Graph
button at the lower left. The Filter Specs 'Pick from List' Details
graph on the next screen is
produced.

Lift Filtering |S-:ume [including meas. w eleu:j

WVeldcocelllerk Filkering Moderate -

Cylinders to Graph

Jehdd

Cylz to Graph |1¢‘I Only

LA L1

Page 5 Make Graph | Help | Cancel | Print |




The Actual Cam Profile is the green graph and you can see it is much more narrow than the Cam Lift profile. You have
probably noticed this on flat tappet cams, that the lobe on the cam itself is very pointy.

& Cam Analyzer v4.3 [ CF236F.5097 |
Back Fie Format View Analyze GraphType Add Test HistoryLog Mulitple Tests Help

2 2 2 O 5 = I 4 Y e
Cam Analyzer v4.3, Int Data 1#1

Int Cam Lift,inches

Int Cam Proﬁle,inchels

27400

25000

22400

20000

7800

16000

12500

10000

07300

.0a000

02400

.0aooo

-02600

-03000 Cam Deqg

E Cam Analyzer v4. 3 ‘'Cam Grinder” Performance Tren
#W Edit Graphs Reports  TeskfCam Setup  Find TDC  Settings
EZ Skart Wizard (new, EZ method Far Mew Test)

Mew (classic way ko skark new besk) ChEl+I

Open {from all saved tesks) Chrl4+0 st Com
Return to the Main Screen, click on File, then Export Open from History Log
Manufacturing Style Cam File. You will be presented with Save Chrl+5
the form on the next page. Save As Chrl+A

Cpen From FloppyCD Drive (8 Drive)
Save ko FloppyCD Drive (A, Drive)

4303
Imnpork L4

Export as Cam Dr File {and other Formats)

Export Manufacturing Style Cam File
Email This Cam Test File

Backup
Restore from a Backup »

Peimk B -im Cremme
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Here choose m. Export Mfz File Options _ w. Form1 E]@@

::GOEI’:a?ZSat:Cei a Mg Cam File Specs

Fars o Format  [ClEIGis XY to 3D IGS creator
destination for the File Hame Carroll cf23E6FI1GS |

file.

I File Destination Path Browse |

Setting Zero Out ||:: B3N projectzESCam-anzr |

Runout is a good

choice to no? SEFENE | Commas () |

produce any Thickness. 2
_measgred runoyt Lobe to Lze [Lobe Int 1 =] T

into this IGES file. Make Master Cam? [0 = Create 1G5 ‘
Click on the Make [ ]

File button to Zero Out Bunout? Yes -

produce the IGES

file.

Then enter the

thickness you !I"lf?tez facturing fil ted iz b d th

: = manufacturing file created iz based on the
want for this lobe. current cam meazurements on the Main Screen
[the zcreen behind thiz screen). This data will be
far the actual cam profile az if measured by a
'khife edge' fDIIDw_Er, not & rounded pn:iinte_r or ! ) .
roller follawer. This data is most accurate if File C:1VB981projectstl Cameanar| Carrall cf236F, 165 written
measured with a inear encoder pointer directly on
the cam lobe, because lezz commechion for a
radiuz iz required.

Cam Analyzer

M ake File | Help | Cancel | Print |

Shown below is what the file looks like in Notepad.

B cCarroll cf235f.1GS - Motepad

Fil= Edit Format Wiew Help

IGS from Cam Analyzer wh_.3 B S08000a1 ~

1H, ,1H; ,2BHHASTERCAM version X9 ,14HTempIGS0.mcx-9 ,11HHASTERCAMKXY ,1H1,16,G88088881

8,24,8,56,,1.,1,4HIHCH,1,8.81,13H248511.161111,8.868080868801 ,1688.,,,8,0,; GAAOBBAZ
486 1 1 1 1 a 8008083 068D BABAAA1
LBG a 1 1 15 aDaaBaoea2
314 2 1 1 1 a8 A0AARAAAD AOBAAA3
314 a a 1 a BDAAAAAAY
118 3 1 1 1 a B0008080AD BOBA0AS
118 a -3 1 a 8D BOBA0AG
118 U 1 1 1 a8 A0AABAAAD AOBAAAT
118 a -3 1 a BDAAAAAAB
118 5 1 1 1 a B0008080AD BOBA0AY
118 a -3 1 a apaaBeae1a
118 6 1 1 1 a8 A0PAAAABD AAAAA11
118 a -3 1 a apaaAAA12
118 7 1 1 1 a B0008080AD BOBA013
118 a -3 1 a aDaaBeaea1Y
118 8 1 1 1 a8 A0AARAAAD AAAAA1S
118 a -3 1 a aDAaAAnA16
118 9 1 1 1 a B00080808D BABAB17
118 a -3 1 a BDaoBae18
118 18 1 1 1 a8 A0AARAAAD AAAAA1D
118 a -3 1 a BDAAAAAZ A &

Ln1, Caol 1
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Procedure for Doing Arcs w| Export Mfg File Options

Mig Cam File Specs

Format | v 7 Data [2=0) -]
At the Main Screen, click on File, then Export Manufacturing Style Cam File N
File. You will be presented with the form to the right. re Hame [Example <2 |
Select the Format “X, Y, Z Data”. This will be a 2D file. You will have to | | e Destination Path _Browse |
do some conversions in your CAD software to produce a solid from this LB 3B\projectsB\Cam-anar |
comprised of arcs.

Separator ||:|:|mmas [l

Lobe ta Use |Lobe Int #1
b ake b aster Cam? |N|:|

Dbb Kl

Zero Out Runout? ez -

]

MHote:

The manufactunng file created i= bazed on the
current cam measurements on the kain Screen
[the screen behind thiz screen). This data will be
for the actual cam profile as if meazured by a
'knife edge’ follower, not a rounded pointer or
roller follower. Thiz data iz most accurate if
measured with a linear encoder painter directly an
the cam lobe, because less comection for a
radiug is required.

Click Make File at the lower left to produce the XYZ file. This file is Make File | Help | Cancel | Print |
shown in

NOtepad. B cam xy=.txdt - Notepad Q@E|

Fil=e Edit Format Yiew Help

|-2723972,- _5346161,0_ 00000008 -
J2817119 ,—- 52982346, 0. 0000000
-29094481 - S2487F77 80000000
-3888777 ,—- .5197504 ,8_0000000
-3891720,- 5145402 _A_0000000
3181781 ,- 5891219, 8. 0000000
-3279924 .- 50836786 ,08.0000000
-3359139,- 4989134, 0._0000000
3440481 ,-.4922091,0.00080040
-3532393,-.4861927 ,0.8000080040
36172408 ,- . 4800245 ., 0. 00080040
37010 L, - 4737887 ,0.00000040
-37¥8308L, - 4672446006 ,0.00000040
-3865183 ,- . 4606351 ,0.00000040
-3945395 .- 4538663 ,0. 00000040
~AB24425 - 4469582 ., 000000040
182247 - 4399127 ,8.000080040
178827 .- 4327308 ,0.00000040
SA254216 ,—- 4254227 . 8.800080040
4328112 ,- . 4179615 , 0. 0000000
4488697 - 4183722 ,0.0000000
AL F1951 ,- 4826568 , 0. 0000000
SASH1852 - 3948178 ,0. 0000000
4618388 ,- .3868580,0. 0000000

Page 9 Ln 1, Cal 1




You will have to do some conversions in your design software to make solids out of the XYZ file from Cam Analyzer.

To do arcs in SolidWorks go to:
1. File -> New... -> Part -> OK.

2. Set units accordingly units saved in *.txt file here: Settings - > Document Properties - > Units (inches in the case of
this file)

3. Insert -> Curve -> Curve Through XYZ Points... -> Browse...

Change file type from Curves (*.sldcrv) to Text Files (*.txt), select file and open it. Press OK.
4. Zoom to Selection or Zoom to Fit.

Now you can change Units setting back if needed.

Here are steps to create solid figure after points are imported:

5. Select Front Plane, then Sketch, then Curve1 and Convert Entities.

6. Insert -> Boss/Base -> Extrude... -> enter Depth and confirm with green check sign (OK).

Here are instructions for MasterCam.

1. SETTINGS -> Configuration... -> Start/Exit -> Current:, choose <English> or <Metric> units according to your file data,
confirm with green check sign.

2. File -> Open, select file type ASCII Files (*.txt;*.csv;*.doc), select file with points clicking just once, don't open it now,
go to appeared Options, select Entity Creation Splines, confirm with green check sign, then click Open.

3. SOLIDS -> Extrude... -> select contour, confirm with green check sign, change Distance, confirm with green check
sign.



